Introduction to Enterprise Guide

Welcome:

Information Technology Division (ITD) - http://www.ncsu.edu/it/
Computing Services Workshops - http://www.ncsu.edu/it/education/schedule/
Instructors:

Laura Grady (laura_grady@ncsu.edu)

Larry Robinson (larry_robinson@ncsu.edu)

Objectives and Goals
In this class you will learn how to: 

· Obtain Enterprise Guide (EG) Software

· Learn about the Enterprise Guide Environment (EG)

· Create an EG Project including…

· Explore and manipulate Data in Enterprise Guide (EG)

· Calculate statistical information

· Create queries

· Create the SAS portion of an HTML report

Materials (provided for you)
In this class we will use:

· EG 2.0 

· Handout with Exercises

· Practice data (will be provided for you)
Index / Outline
· Obtaining Enterprise Guide Software

· Enterprise Guide Environment

· Enterprise Guide project structure

· Enterprise Guide windows

· Starting Enterprise Guide

· Data Exploration, Analysis and Reporting by Example

· Inserting Data and Notes

· Data Exploration

· Creating New Variables

· Inserting additional Data

· Using Query Builder

· Joining Tables using Query Builder

· Survey results by Example

· Creating HTML output

· Getting Help
Obtaining Enterprise Guide Software

· Where do I get a copy of EG?
· EG only works on Windows operating systems

· EG requires SAS also be installed

· Request software here: http://www.ncsu.edu/it/sas
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· Click on [image: image2.png]l Request Software



to complete the request form.

EG is also available in the UNITY LABs

For locations and other details about the Unity Labs (including hours of operation and types of machines) visit the web page listed below: 
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http://www.ncsu.edu/it/labs

 Enterprise Guide Environment

Objectives
· State the capabilities and major features of EG software

· State the purpose of the different areas of the EG workspace

· Outline the steps in a typical EG session

[image: image3.wmf]Introduction to Enterprise Guide


Enterprise Guide software is an easy-to-use Windows application that provides
· an intuitive, visual interface

· access to the power of SAS

· transparent access to data

· ready-to-use tasks for analysis and reporting

· easy exporting of data and results to other applications
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Introduction to Enterprise Guide


Enterprise Guide provides a state-of-the-art Windows interface with XE "Enterprise Guide:features" 
· drag-and-drop functionality

· dialog boxes

· wizards

· a color-coded syntax editor

· a Help Agent and full Online Help facility.

Using Enterprise Guide, you can access the power of the SAS System without learning the SAS programming language. If you are a SAS programmer, you can use the Enterprise Guide code editor to create new code or modify existing SAS programs.
Creating a Project:


[image: image5]
The Project Tree:
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EG Environment: 
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You can accomplish tasks using the Tasks by Category pane, the Tasks by Name pane or by using menus.
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Work Area
     Results are sent to the Work Area.  You have the ability to format your results.  You can also…
· Insert results in Microsoft word and Microsoft PowerPoint
· E-mail or save results as HTML files and publish on the web
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Write, Modify or Run SAS code
You can write new SAS code, Modify existing SAS code and Run SAS programs (new or existing) from within Enterprise Guide.  To open existing Code, select Insert -> Code -> Existing and navigate to your .sas file. To run sas code, use the Code menu or click on the run button [image: image53.png]& Enterprice G NI
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(class example = Itd\Enterprise Guide\run_code_example.sas)
[image: image11.wmf]As you build tasks, Enterprise Guide generates SAS code.

Behind the Scenes


Review:

· Overview of  several Enterprise Guide features
· Discussed the Enterprise Guide Project

· Discussed the Enterprise Guide environment

Access Enterprise Guide on Windows PCs in the Unity Labs

HOW TO LAUNCH EG ON YOUR WORKSTATION

To access EG in the Unity labs, use the Application Launcher.  
Double click on Enterprise Guide 2.0 
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To access SAS on your home computer

Go to your Start Menu Programs  ‘SAS’   ‘Enterprise Guide V2’
You may also place a shortcut on your desktop to reduce this process.

Recall that you need to have SAS already installed for Enterprise Guide to work.

· Launch Enterprise Guide 2.0 now if it is not already running
Data Exploration, Analysis and Reporting by Example
Objectives:

· Explore the Enterprise Guide environment

· Conduct data exploration and analysis

· Use queries to create new variables and filter data

· Generate a simple report

Background on the class Sample Dataset
· Nutritional information was collected on a sample of candy bars.  
· The data set contains 17 pieces of information about 75 different candy bars.  The columns in the data set are Brand, Name, Servings, Weight, TotalCalories, TotalFat, SatFat, Cholesterol, Sodium, Carbohydrate, Fiber, Sugars, Protein, VitatminA, VitaminC, Calcium and Iron.

Inserting Data and Notes

When you open Enterprise Guide, you will see a dialog asking whether you want to create a new project or open an existing project.  
· Click on the Create New Project button
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· Insert Data into this project
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1. Click on the Insert menu 

2. Click on Data
3. [image: image55.png]


Click on the Existing Tab 

4. Select Files of type appropriate to your data type : Microsoft Excel Files (.xls) 
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5. Browse to your data

6. Click on the OK button

Enterprise Guide data tables will display: 

In the protected / Read-only mode

Variables in Columns

Observations in Rows

Variable types with symbols

red pyramid is Character Data and blue circle is Numeric data
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Missing Character Data as empty cells


Missing Numeric Data as cells with a . (dot) in them

Notice that the project we have created now contains one element, a data set.
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It is possible to add additional elements to the project.

· Insert a text file that contains a description of the data into this project
1. Click on the Insert menu 
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3. Click on the New tab

4. Give your Note a name and then

5. Click on the OK button

6. Type your note

7. Click on the X to close the note
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Using notes is an excellent way for Educators to include information about assignments. For instance, the note could be instructions on a homework assignment.   If you are going to do this, remember that the actual text file must be saved in a location students can access.

It is also possible to add text, html or word documents to your project.  

1. Select the Insert menu 

2. Select File 

3. (select your Files of Type to be txt, html or doc) 
4. (navigate to your file) 

5. click Open

Note that just as with the data, your project does not include an actually copy of the files you insert. Instead, it simply points to the location of this file.  If this file is changed in its original location, this change will be reflected in your project. Similarly, it the file is deleted, you will receive an error message in Enterprise Guide when trying to access the file.
(class example: insert the file ITD\Enterprise Guide\Homework Assignment 10.txt)

Data Exploration

(These examples are meant to familiarize students with the Enterprise Guide dialog boxes, not to suggest valid statistical methods for complete data exploration)

Examine the distributions of the variables.  This can be done with tasks under the Descriptive Category in the Analysis menu.  Analyze the distribution of the variables Calories and Carbohydrate

1. Select Analysis   Description Summary Statistics…
2. On the Columns tab, control-click to select the variable Calories and Carbohydrates.

3. Drag these variables from the Variables to assign: pane to the Analysis variables role in the Summary statistics roles pane as shown below                 
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4. Select the Statistics tab.

5. On the Statistics tab, deselect the Number of observations and change the  Maximum decimal places from Best fit to 3 
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6. Select the Plots tab.

7. On the Plots tab, select Histogram. 
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8. Click on the Finish button to generate the descriptive statistics and histograms.
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The average candy in the sample has approximately 243 calories with 31 grams of carbohydrate.  However, looking at the histogram, the variable Calories is skewed to the right with some unusually high values.
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The variable Carbohydrate is also skewed to the right.

Further analysis of the other variables in the data table shows that many of them also appear skewed to the right with a few unusually large values.  After careful examination, it appears that the number of servings in the package may be causing this.  
Examine the values for the variable Servings using a one way frequency table.

[image: image56.png]Tty oty | st by |

Create MDDB B
Regster MDDB
Random Sample
‘Append Table:
Extract Cube Data
Descriptive
List Data
Summery Statistcs
Distribution Analyss

One-Way Frequenciss

Table Analysis
Table Analysis
anova
tTest
One-Way ANOVA
Nonparametric One-Way ANOVA
Linear Madkls
Mixed Models
Regression |





· Create a One-Way Frequency table
1. In the Tasks by Category pane, scroll to Descriptive. 

2. Select One-Way Frequencies.
3. On the Columns tab, select Servings and drag it from the Variables to assign pane to the Analysis variables role.

4. Click on the Finish button.
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Notice that while almost 87% of the candies in the data set are single serving packages, there are some multiple serving packages included.  You might choose to take all the measurements and make them single servings.  This can be done using the Create Query using Active Data task.  
· Create a new variable

1. Select Tools  Query  Create from Active Data… 

2. Click on the Select and Sort tab

3. Click on the New… button
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4. In the new dialog, assign the alias Weight1 to the column being created.
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5. Select the Expression tab to open the Expression Builder dialog and define the Weight1 column.
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6. To add Weight to the expression, double-click on Weight in the Value pane.

7. Type or select the / sign after Weight.

8. To add Servings to the expression, double-click on Servings in the Value pane.

9. Select OK to exit the new dialog.

You can now see your new variable.  It will be easier for us if Weight1 is situated closer to the location of Weight so…

10. With the row for the new variable Weight1 selected, click the Move Up button multiple times until the new column is next to the original variable Weight.  
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11. We not longer need the original variable Weight.  To remove it, deselect the row for Weight in the first column of the Select and Sort tab.
12. Select Run Query.

For the sake of time, we will continue the demonstration with the data set Candy1.  This data set already has each of the variables changed to per serving values.
· Insert additional data into the project:

1. Select File  Open
2. Verify or set Files of Type to be SAS Data Files
3. Select candy1.sas7bat
4. Select OK
· Examine the distribution of Calories and Carbohydrate in the new data set.

1. Select Analysis  Descriptive   Distribution Analysis…
2. On the Columns tab, select the variables Calories and Carbohydrate.

3. Drag these variables to the Analysis variable role in the Distribution Analysis roles pane.

4. Select the Plots tab.

5. On the Plots tab, select Histogram
6. Select the Results tab.
7. To remove the test for location from the output, select Test for Location, and then select Remove Table.
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8. To add additional tables to the output, select Add New Table…
9. Add Moments and Quantiles to Tables to include:
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10. Select OK and then Select Finish.

Notice that the skewness statistic is now very close to zero indicating that the data is only slightly skewed to the right. 
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The mean and the median for the variable Calories are also very close to each other, again indicating a symmetric distribution.
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The remaining tables and histograms indicate additional features of this data set. 
Lets continue to explore the data by examining the correlations between Calories and the other variables.

1. Clear the workspace by selecting Window -> Close All
2. Make sure the Candy1 data table is highlighted in the project tree. This ensures that Candy1 is the active data set.

3. Select Analysis  Descriptive  Correlations…
4. Select the variable Servings in the Variable to assign pane. Shift-Click on the variable Iron to select Iron and all the variables between Servings and Iron.

5. Control-Click to deselect the variable Calories.

6. Drag the selected variables to the right to be correlations variables

7. Select the variable Calories
8. Assign Calories to the Correlate with role by dragging and dropping.

9. Select the Correlations tab. Examine the options available

10. Select the Results tab

11. In the Results tab, select Create a scatter plot for each correlation pair.

12. Select finish.

In addition to two-dimensional scatter plots, you can also produce three-dimensional scatter plots. To illustrate this, generate a 3D scatter plot with the variable Weight, TotalFat and Calories.

1. Select Graph  Scatter…

2. In the Chart Gallery, select 3D Scatter Plot
3. Select the Columns tab.

4. Assign Weight as the Horizontal variable, Calories ad the Vertical Variable, and TotalFat as the Depth variable.

5. Select the Appearance tab.

6. Change the Symbol type to Sphere and the Symbol color to red. 

7. Select Finish                              [image: image33.png]HSsas. ‘ Enterprise Guides
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8. The Symbols on the resulting plot appear to be too large.  To fix this…

9. Right click on the chart (not on the gray background) and select Scatter Options…
10. Using the slide bar for Size, change the size of the scatter plot symbols.

11. When you have a size you like, select OK.
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12. You can rotate the graph by holding down the control key on your keyboard and moving the graph with your mouse.  You can also observe the values graphed for any one point by pointing at the symbol with your cursor.

(Note : If you have Active X installed, you can copy this 3D scatter plot into a PowerPoint presentation and it will maintain the active characteristics.)

From the analysis run so far, you can see that it is easy to explore your data. Close all windows now by selecting Window  Close All before proceeding to the next demonstration.
What we have shown so far is:


How to create a new project


How to insert data into a project


Where to find the point and click analysis tools in Enterprise Guide


How to use the Query Builder to create a new variable 

How to perform analysis using Enterprise Guide
Now we will use the Query Builder to subset our data

· Using the query builder to filter data.

1. Make sure the Candy1 data table is highlighted in the project tree

2. Select (double click) Create Query using Active Data from the Tasks by Category pane.
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Create a data set with only candy bars containing more than 200 calories by:

3. Drag Calories from the left pane to the Filter Data pane

[image: image36.png][A_Enterprise_Guide_Semira
Brand
Name
Servings
weight
Caloies
TotalFat
SatFat
Chalesteral
Sodim
Carbohydhate
Fiber

Sugars
Protein

Vianina
| f

iter bt | st o] e

[orag a calumn from the lft pane to set a.

@ Calories





4. In the Edit Filter Condition dialog box, change the Operator to >, greater than and enter a value of 200.
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5. Click on OK.
6. Click on Run Query
You can also use the Query Builder to Join Tables…

Joining Tables using Query Builder

Example: We want to join two tables based on a common variable ID.
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1. Insert Data – Select customer_data.sas7bat
2. Select customer_data.sas7bat  to make sure it is the active data set

3. Select (double click) Create Query using Active Data from the Tasks by Category pane.
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4. Click on the Add Data button
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5. Select  sales_info.sas7bat and click on the OK button
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6. Select the Tables tab.  Notice that Enterprise Guide has already determined which variable(s) these two data sets have in common.

At this point, you may also go to the Select and Sort tab to select which columns you want to appear in your new, combined data set.  You also have the option to sort your results.

7. Click on the Run Query button when you are finished making selections.
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To save the data set you have just created.

1. Right click on your new data set

2. Select  SAS (filename) As/Export..
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Recall that you can rerun your query and make changes as needed by simply double clicking on the Query item in your project tree.

It is also helpful to rename your queries and data sets here to make your project tree entries more meaningful.

Survey Results by Example

Now add another data set to your project. 

Insert  Data and select survey.xls (choose to add sheet 1 “raw_data”)
[image: image44.png]) Fle Eok_vew Insert Fomek Took Dats Andyss Groph Code Window Felp

[DEER&E] s mex |2 am

[EEEEE I rr—-|

BF) * cate & cont_retng | hotelrating
& [ Projest 1 [fwbes 2moratfaverse Good
1] Ki\classes _Tteach\Enterprise Guide Files\survey sl (Local)| [7—fpec 3 578 % Averege oo
5 [wed Dec 308401 Average Excelert
[ [wed Dec 308552 Average Good
5 [wed Dec 310552 Aversge Poor

Bar Chart for Ki\classe:

teach)\Enterprise G

Chat Gl | Counns | Appearce | Advrced

Simple Vettical Bar

E
2

Grouped Verical Bar Stacked Verical Bar  Grouped/Stacked  Vertcal Colored Bars
Vettcal Bar

E
=1
2
&

GioupedVerical  GroupedVetical  Inlereaved Vetical 3D Grouped Verlical 3D Grouped Stacked
Colored Bars Colored Groups Bar Bars Vertcal Bare

. !

e —

I™ Previewtask code.

2
i
M

it | Ne> | i | cown | s |

[cohn: You st s ok £ the ok o chart 1o

Tty oty | sk by

ot { [B__[wedbec 30834 [Excelent Excelert
s S3Jviite: st zbotn oot
i N T e
venm S Jrieite: st bon oo
Lt R T
paretochrt S Jreite: sceon o (Bt
i crt S Jvite: scatiSbon skt
v senes Slveson: 305123 it v
Prepare Time Series Data El [Wed Dec 3 09:29:0 |Excellert Excellert
o et in—Jreite: stz o [esiot
ARIMA Modeiing and Forecasting 41 [iWed Dec 3 09:48:5 Excellent [Excellent
Ry s i Ao s I VStai ol I o
| Lot prslonts 3 Jreite: 31023 ot [esiot
o iJveite: 310 Sbotn skt
= EENCET e —





Make a Bar chart showing overall conference rating (conf_rating).

1. From the Tasks by Category window, select 

Graphs      Bar  accept the default “simple vertical bar”
2. Click Next or Select the Columns tab.
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3. On the Columns tab, select conf_rating and move it to the Simple Roles pane under Columns to chart.

4. Click Next or click on the Appearance tab.
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5. On the Appearance tab, Specify the Bar values.  You will do this so that the presentation of bars will be in a particular order.  If you did not Specify the bar values, Enterprise Guide would chart them in alphabetical order. The values to enter are (in this order) Excellent, Good, Average, Fair and Poor.

6. OPTIONAL… you may select from many colors and textures on the Appearance tab as well.  You would also give your output a meaningful name by clicking on the Titles button.  Feel free to experiment.

7. Click on the Next button or Select the Advanced tab.
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8. On the Advanced tab, add additional statistical values to display on the chart:

a. Place a checkmark next to Additional statistical value to show next to bar: 

b. Select Percentage

9. Click on Finish
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10. Use the Query Builder to select just those entries that include comments

a. Select Create Query using Active Data 

b. Drag the variable Comments to the Filter Data area

c. Click on the Column Values button

d. Select “ to represent the blank comments 

e. Check in the Apply NOT to filter box 
f. Click on OK

g. Click on Run Query
11. Now present the comments in a List

a. Make sure the data set created by our Query is selected [image: image49.png]Query1 for LAITD\Enterprise Guidelsurvey.xls (Local
D s o survey.xis (Local)
Code

] o
=





b. Select Descriptive List Data
c. Select Comments as the List Variable
d. Select hotel_rating for Group table by

e. Select hotel_rating for Identifying label    
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f.  Click Finish

Now that we have some results in the project tree, we will learn how to create a report.

Close all windows in the project by selecting Window  Close All.

· Creating an HTML Report using the Document Builder

1. Select Tools  Document Builder…
2. Change the name of the document to something meaningful

3. Click on the Add Results button

4. Select the items you want to add (use the ctrl key to select multiple items)
5. Click on OK
Your document has now been saved to the project.

To save the HTML file outside of Enterprise Guide

1. Right-click on the document you just created

2. Select Save As/Export (the name of your document will be inserted here)

3. Choose a location

4. Click on the OK button

At this point, you can open the html file with your favorite html editor.

· Save a picture or graph
1. Right click on one of the histograms
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2. Select Save Picture As
3. Choose type (default is GIF, BMP is also a choice)
4. Choose a location

At this point, you can add the picture to other documents you are creating.
Where to get help:

NCSU Help Desk -> 515-HELP (515-4357) or help@ncsu.edu
SAS Help Desk -> 677-8008 opt2 for new questions (site ID=27585003)

SAS Online assistance -> http://support.sas.com/techsup/

Laura Grady -> laura_grady@ncsu.edu
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To begin work with Enterprise Guide, you





1. Create a project





2. Add data to the project





3. Run tasks against the data.
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